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0100 CARES Comm Team Lead Checklist 
City of Cupertino       Emergency Plan/Plans Section 
 
CARES/Communications Branch Checklist 
Mission:  The objective of the Cupertino Amateur Radio Emergency Service (CARES) is to provide 
alternate communications pathways, field intelligence, and technical expertise to support the city’s 
emergency response. 

1.  Before the event 
_______ 1. Review/update CARES/Communications section of Emergency Plan 
_______ 2. Review/update CARES roster 
_______ 3. Meet monthly with members to share ideas 
_______ 4. Check antenna drops 
_______ 5.  Conduct exercises 
_______ 6. Provide EOC training as needed 

2.  During the event 
_______ 7. Report to EOC and sign in 
_______ 8. Put on EOC vest 
_______ 9. Write name on organization chart 
_______ 10. Obtain briefing from Section chiefs or published situation report 
_______ 11. Determine name of your relief and attempt to contact 
_______ 12. Begin and maintain a Unit Log (ICS-214) 
_______ 13. Document everything! 
_______ 14. Dispatch members to fire stations 
_______ 15. Dispatch member to Cupertino Clinic 
_______ 16. Log in to County Net 
_______ 17. Monitor the EOC to EOC radio 
_______ 18. Maintain status of CARES field units 
_______ 19. Provide situation status reports to Plans Section 
_______ 20. Welfare check CERT Communities (refer to CERT list) 
_______ 21. Disseminate all pertinent information received to appropriate Section Chief 
_______ 22. Review EOC Action Plan and participate in the development of the Plans Section 

Action Plan to support and accomplish the goals 
_______ 23. Develop the CARES Communications Action Plan (see Section 4 below) 
_______ 24. For Extended Response Operations, develop the staffing plan and shift rotation 

schedule for field units 
_______ 25. Arrange for material support (food, shelter, power) for field units with Logistics 

Section. 
_______ 26. Don’t release any information to the media unless authorized by PIO 
_______ 27. If there is little or no damage to the City, be prepared to provide mutual aid to other 

cities/operational areas throughout the stare 
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3.  After the Event 
_______ 28. Complete all paperwork. 
_______ 29. Submit all receipts to Finance Section 
_______ 30. Determine need to restock equipment/supplies for your position. 

 
_______ 31. Prepare a list of lessons learned, needed changes to checklists, and requests for 

additional supplies/equipment 
_______ 32. Coordinate with Personnel Branch to debrief all personnel in your branch (including 

volunteers) who have participated in the emergency, and be aware of critical incident 
stress symptoms 

_______ 33. Leave a forwarding phone number where you can be reached, with the Emergency 
Services Coordinator 

4.  Communications Action Plan 
The Communications Action Plan should contain the following information: 

 1. Operational Objectives.  Summarize the situation and the emergency communications 
need.  Develop the Objectives for this Operational Period.  These objectives must align with 
and support the EOC Operational Objectives. 
Use form ICS 202 INCIDENT OBJECTIVES. 

 2. Deployment Plan.  Identify the field assignments or stations where CARES resources need 
to be assigned. 
Use form ICS 204 ASSIGNMENT LIST. 

 3. Resource Plan.  Develop the list of resources to staff the field assignments or stations for 
the current and future shifts (next 36 hours).  Identify any special equipment required at 
each assignment. 
Use form ICS 204 ASSIGNMENT LIST. 

 4. Frequency Plan.  Identify what frequencies are in use and how they are used. 
Use form ICS 205 INCIDENT RADIO COMMUNICATIONS PLAN. 
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0200 CARES Net Control Station Checklist 

1.  Before the event 
_______ 1. Update CARES/NCS Procedures in SOP. 
_______ 2. Review and practice NCS procedures. 
_______ 3. Perform quarterly antenna checks at the portable NCS operating position. 
_______ 4. Perform quarterly radio transmission checks of the NCS Radio. 

2.  During the event 
_______ 5. Obtain briefing from CARES EC. 
_______ 6. Obtain a copy of the Communications Action Plan from the EC. 
_______ 7. Retrieve the NCS radio from the EOC Radio Room.  Set up the NCS radio at the 

designated location.  Verify power and antenna connections. 
_______ 8. Begin and maintain the NCS Log (see next page for information). 
_______ 9. If the CARES Emergency Net is already running, notify the acting NCS station that 

you are ready to assume the net. 
_______ 10. Call for check-ins.  Log all stations that check into the net.  Record their location. 
_______ 11. Establish a Frequency Guard on these commercial stations: 

KCBS 740 KHz  LP1, Public AM station 
KSJO 92.3 MHz  LP2, Public FM station 
KQED 88.5 MHz  LP3, Public FM station 
If resources are available, establish a Frequency Guard on these additional stations: 
KLIV 1590 KHz  Public AM station (local CNN News) 
K6FB 145.45- PL=100 High-level repeater, Sierras to coast. 
W6ASH 145.270  SPECS, Mtn View to Redwood City 

_______ 12. Answer calls for traffic.  Determine the availability of the RECEIVING station.  Direct 
the SENDING station to pass their traffic to the RECEIVING station. 

_______ 13. During periods of high traffic volume, call for traffic in priority order: EMERGENCY, 
then Priority (see next page for definitions). 
 * EMERGENCY – Life Threatening 
 * URGENT – Property Threatening 
 * Priority – damage reports, material and logistics messages, etc 
 * Routine – welfare inquiries, routine resource requests, shift planning, etc 

4.  Every 15 minutes -- DRILL 
_______ 14. Make this announcement: 

This is <your_call>, Net Control Operator for the Cupertino ARES Net.   
This is a Drill.  All messages should be considered as DRILL traffic. 

5.  Every 30 minutes -- Activation 
_______ 15. Make this announcement: 

This is <your_call>, Net Control for the Cupertino ARES Emergency Net. 
This is a directed net.  Permission to pass traffic is required by Net Control. 

_______ 16. Perform a health and welfare check of all checked in CARES members.  
 * Call each checked in station and wait for an acknowledgement.   
 * Call for any other new check-ins. 
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6.  Shift Change 
_______ 17. When contacted by the next shift CARES member, review all relevant information 

and status (see next page for information). 
_______ 18. Make the appropriate shift change entry on the NCS Log. 
_______ 19. The person being relieved informs the EC of the shift change. 

7.  After the Event 
_______ 20. Perform a final Health and Welfare check. 
_______ 21. Secure the net. 
_______ 22. If operating portable, pack up the NCS radio. 
_______ 23. Prepare a list of lessons learned, needed changes to checklists, and requests for 

additional supplies/equipment. 

8.  Shift Change Information 
Review the following information during a shift change. 
1. The radio channel(s) in use  (CH #1: 147.570 MHz, CH #2: 146.460 MHz). 
2. Any other radio, power, or antenna details. 
3. List of checked in members; call signs, tactical call signs, and location. 
4. Review the Log. 
5. What is going on in general; what changes are expected. 
6. Any pending activity: messages, replies, and action items. 
7. Site logistics:  toilet, food, water, etc. 

9.  NCS Log 
1. Use this NCS Log to capture message requests between stations.  Create this form if not 

available.   
2. The definitions of the columns are as follows: 

(1) Message ID.  The ID number assigned once the originating station is granted permission to 
send its traffic. 

(2) Priority.  The Urgency of the message (see below). 
(3) Time.  The time when the request to pass traffic was received. 
(4) Originating station.  The Tactical or FCC Call sign of the initiating (From) station. 
(5) Receiving Station.  The Tactical or FCC Call sign of the receiving (To) station. 
(6) Time Ack.  The time the Receiving Station acknowledges the message. 

3. If an official NCS Log is not available, draw 6 columns on a sheet of paper as shown below. 

DATE:__________________      Event No:____________________ 
(1) 

Msg ID 
(2) 

Priority 
(3) 

Time In 
(4) 

Originating Station 
(5) 

Receiving Station 
(6) 

Time Ack 
      
      
      



Cupertino Amateur Radio Emergency Service  Standard Operating Procedures 
PART 5  Checklists 
 

8/3/2014 8:51:00 PM Rev 4.1  January 2010   7 

0300 CARES Field Site Response Checklist 

This checklist is used by operators assigned to Fire Stations in Cupertino. 

1.  Before the event 
_______ 1. Review/Update the CARES/Field Site Response Plan. 
_______ 2. Inventory and update your Basic Deployment Equipment (see Section 7) 

2.  During the event; first shift 
_______ 3. Report to EOC and sign in. 
_______ 4. Get a tactical Call Sign and frequency. 
_______ 5. Pick up the Response Kit.  Inventory its contents  

(see Section 6). 
_______ 6. Proceed to your assigned Fire Station, shelter, or medical center. 
_______ 7. Find and check in with the Fire Station Captain (if available), or individual in charge, 

and notify them of your presence. 
_______ 8. Locate the Antenna Drop.  See the attached map. 
_______ 9. If required, find and establish a workspace and set up any equipment and processes. 
_______ 10. Connect the Antenna Drop extender cable located in the response kit. 
_______ 11. Connect the necessary adapters between the extender cable and your radio. 
_______ 12. Begin and maintain the Field Station Log. 
_______ 13. Check in with Net Control and inform them the position is staffed. 
_______ 14. Originate and receive CARES net traffic for your location as necessary. 
_______ 15. Provide situation status reports to the EOC, Plans Section. 

3.  Shift Change 
_______ 16. When contacted by the next shift CARES member, review all relevant information 

and status (see next page, Section 5). 
_______ 17. Find and inform Person in Charge of the shift change.  Introduce your replacement. 
_______ 18. Make the appropriate shift change entry in the Field Station Log. 
_______ 19. Check in with Net Control and inform them of the shift change. 
_______ 20. Perform Steps 13 and 14 above as required. 

4.  After the Event 
_______ 21. Complete all paperwork.  Make final Field Station Log entries. 
_______ 22. Submit all logs, receipts, and paperwork to the CARES EC. 
_______ 23. Determine the need to restock equipment/supplies for the response kit. 

 24. Return Response Kit to EOC.  Notify the EC of any material to be replaced. 
_______ 25. Participate in the event debrief session to identify needed changes to methods, 

material, or procedures. 
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5.  Shift Change Information 
Review the following information during a shift change. 
1. The radio channel(s) in use  (CH #1: 147.570 MHz, CH #2: 146.460 MHz). 
2. Any other radio, power, or antenna details. 
3. All the tactical call signs and where the stations are located; include names and FCC call signs 

if known. 
4. Review the Log. 
5. If a telephone is accessible, its location and the phone number  ____________________ 
6. The officials or others you are serving; how to find and recognize them. 
7. The purpose of the station. 
8. Any station protocol, 
9. What is going on in general.  What changes are expected. 
10. Any pending activity: messages you have sent, replies you expect, and who should get them. 
11. Where is the toilet, food, water, etc. 

6.  Response Kit Inventory 
_______ 1. Field Site Response Checklist 
_______ 2. Field Site Response Kit Inventory List 
_______ 3. Map to City Field Sites  
_______ 4. Antenna Drop location reference 
_______ 5. Antenna Drop Extender Cable, 50 ft, BNC-to-BNC 
_______ 6. BNC Male-to-Male adapter 
_______ 7. SMA-to-BNC Male adapter 
_______ 8. Tool Kit (Screw Driver, Pliers, Tie Wraps)  
_______ 9. Field Station Logs 
_______ 10. Postits, 3” x 5” 2 pads ea 
_______ 11. Pens, Pencils, qty 2 
_______ 12. Pencil Sharpener 
_______ 13. Pad of Paper, qty 2 
_______ 14. Clip Board 

7.  What you should bring -- Basic Deployment Equipment  
_______ 1. 2 Meter HandiTalkie (HT), additional power source 
_______ 2. DSW Card, FCC License, City Identification Card 
_______ 3. Appropriate Clothing 
_______ 4. Food and water 
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0301 Cupertino Fire Station 1 

 

 

General Information 
Service: Truck 1, Engine 1, Patrol 1 

Address: 20215 Stevens Creek Blvd 
Cross-Street: Stevens Creek Blvd Bet S. DeAnza Blvd 

and Blaney Ave. 
Phone 

Number: 
 

Notes: Park across the street from the Station 
off of Vista Drive. 
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0302 Seven Springs Fire Station 2 

 

 

General Information 
Service: Engine 2, Reserve Engine 102,  

Hazmat 2 
Address: 21000 Seven Springs Pkwy 

Cross-Street: Stelling Road bet Rainbow Ave and 
Prospect Rd 

Phone 
Number: 

 

Notes: 1. Park on Stelling Road. 
2. Find the antenna drop by 

entering from the rear and 
proceeding to the left of the 
Station. 
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0303 Monta Vista Fire Station 7 

 

 

 

General Information 
Service: Engine 7, Battalion 7 

Address: 22620 Stevens Creek Blvd 
Cross-Street: Stevens Creek Blvd and S. Foothill 

Blvd 
Phone 

Number: 
 

Notes:  
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0304 Novacare Medical Center 

 
 

 

General Information 
Service: Novacare Medical Center 

Address: 20289 Stevens Creek Blvd 
Cross-Street: Stevens Creek Blvd and Vista Drive, 

across from Cupertino Fire Station 
Phone 

Number: 
(408) 996-8656 

Notes: Between DeAnza & Vista Dr 
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0305 Quinlan Shelter 

 
 

 

General Information 
Service: Quinlan Center 

Address: 10185 N. Stelling  
Cross-Street: Stevens Creek Blvd and N. Stelling  

Phone 
Number: 

(408) 777-3120 

Notes: Between DeAnza & Vista Dr 
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0400 CARES EOC Radio Room Checklist 

This checklist is used by operators responding to the EOC Radio Room and assigned to the CARES 
and County Voice Net positions.  

1.  Before the event 
_______ 1. Update CARES EOC Radio Room Procedures in SOP as necessary 
_______ 2. Review and practice NCS procedures. 
_______ 3. Perform quarterly radio transmission checks of the EOC Radios. 

2.  During the event; first shift 
_______ 4. Report to EOC and receive your operating position assignment. 
_______ 5. Turn on the following radios (refer to the radio procedures): 

 TM-2530A 2 Meter 
 TM-742A 2 meter/440 
 TM-401B 440 

_______ 6. Get a copy of the Communications Action Plan from the EC. 
_______ 7. Establish radio operation positions per this diagram: 

 
Operating Position #3

Other Channels
EOC-to-EOC
220 Packet Operations

Operating Position #2

County Operations
2 meter Message Net

Operating Position #1

Cupertino Operations
2 meter City Net

Operating Position #4

Comm Team Lead
Cupertino Nets
County Nets

do
or

Operating Position #3

Other Channels
EOC-to-EOC
220 Packet Operations

Operating Position #2

County Operations
2 meter Message Net

Operating Position #1

Cupertino Operations
2 meter City Net

Operating Position #4

Comm Team Lead
Cupertino Nets
County Nets

do
or

 
 

_______ 8. Begin and maintain the Station Log. 
_______ 9. Check in with Net Control and inform them the EOC Radio Room is staffed. 
_______ 10. Receive messages addressed to the EOC.  Ensure you record the following 

information: 
 * From who 
 * Who to reply to 
 * Locations, include cross-streets if necessary 
 * Time received the message 
 

_______ 11. Originate messages from your location as necessary. 
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3.  Shift Change 
_______ 12. When contacted by the next shift CARES member, review all relevant information 

and status (see next page, Section 5). 
_______ 13. Make the appropriate shift change entry in the Station Log. 
_______ 14. The person being relieved informs the EC of the shift change. 
_______ 15. Contact Net Control and inform them of the shift change. 
_______ 16. Perform Steps 9 and 10 above as required. 

4.  After the Event 
_______ 17. Complete all paperwork.  Make final Station Log entries. 
_______ 18. Submit all logs, receipts, and paperwork to the CARES EC. 
_______ 19. Determine the need to restock equipment/supplies for the response kit. 
_______ 20. Participate in the event debrief session to identify needed changes to methods, 

material, or procedures. 

5.  Shift Change Information 
Review the following information during a shift change. 
1. The radio channel(s) in use. 
2. Any other radio, power, or antenna details. 
3. List of checked in members; call signs, tactical call signs, and location. 
4. Review the Log. 
5. What is going on in general; what changes are expected. 
6. Any pending activity: messages, replies, and action items. 
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0410 Kenwood TM-2530A  2 Meter Transceiver Checklist 

1.  Power On Sequence 
_______ 1. Turn on the radio with the VOL / Power knob  (lower, right of center). 
_______ 2. Adjust the Squelch ( right of volume control) until any receiver noise is eliminated. 
_______ 3. Verify the left-most control settings  are set as follows: 

AL  OUT 
PRIO OUT 
LAMP OUT 
REV OUT 
SCAN OUT 
LOW OUT 

_______ 4. Select Memory Mode by pressing the M.CH (Memory Channel) button .  Verify that 
the memory channel selector OUTER RING is illuminated. 

_______ 5. Select the 2 meter channel with the MEMORY CHANNEL selector .  The list of 
frequencies and their programmed channel assignments are listed on the next page.  
Refer to the Communications Action Plan for the frequency assignments. 

_______ 6. The selected frequency display does not show the most two significant digits of the 
frequency.  Add 140 MHz to the displayed frequency for the correct frequency 
number (above example would be 146.970 MHz). 

_______ 7. Microphone operation is as usual. 
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2.  Memory Input (ref: page 16) 
The CARES Frequency line-up should already be loaded in memory.  However, if memory was lost, or 
new frequencies are needed, follow this procedure.   
This example will store 146.115 MHz with a + offset in Memory Channel 4. 

_______ 8. Set the M.CH switch to key mode (memory channel selector OUTER RING is NOT 
illuminated ) 

_______ 9. Enter the Frequency by pressing 6, 1, 1, and 5 keys in order. 
_______ 10. Set the Offset by pressing the OS key (right of keypad #3) to select an offset other 

than the standard offset for that frequency.  Repeatedly pressing the key will scroll 
through all possible selections. 

_______ 11. Rotate the MEMORY CHANNEL selector  until Channel 4 appears in the memory 
channel indicator. 

_______ 12. Press the M key (below keypad #7) to enter the information into memory. 
 

_______ 13. To verify memory channel entry, press the M.CH key (memory channel selector 
OUTER RING is illuminated).  The display should show the frequency and offset. 

3.  Setting PL (ref: page 20) 
 This example will store a PL of 100.0 Hz in memory CH 4. 

_______ 14. Set the M.CH key to memory mode (memory channel selector OUTER RING is 
illuminated) and turn the MEMORY CHANNEL selector  to display “4” in the 
memory channel display indicator. 

_______ 15. Press the TONE switch. 
_______ 16. Turn the MEMORY CHANNEL selector to display 100.0 Hz in the tone frequency 

display.  The T indicator will light. 
_______ 17. Press the M key (below keypad #7) to enter the information into memory. 
_______ 18. Press the TONE switch to return to normal frequency display mode. 

4.  Power Control (ref: page 11) 
_______ 19. Pressing the LOW button (Left group of controls) selects either Low power (5 Watts, 

button is depressed), to High power (25 watts, button is not depressed). 
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0420 Kenwood TM-742A  2 Meter/440 Transceiver Checklist 

 

 

1.  Power On Sequence 
_______ 1. Turn on the radio by pressing the Power Button  (right side). 
_______ 2. Make sure the radio is in a known state, first by pressing the VFO key . 
_______ 3. Then, select Memory Mode by pressing the MR button . 
_______ 4. Adjust the Squelch for 2 meters ( outer ring, center knob in group of 3).  Also, 

adjust the Squelch for 440 (outer ring, right knob in group of 3). 
_______ 5. Adjust the Volume for 2 meters ( inner ring, center knob in group of 3).  Also, 

adjust the volume for 440 (inner ring, right knob in group of 3). 
_______ 6. Select the 2 meter band for transmit by PRESSING the 2 meter BAND SELECT .  

The inner knob is also a push-button.  Verify the “PTT” indicator illuminates above the 
two most significant digits of the frequency. 

_______ 7. Select the 2 meter channel with the Tuning Control .  The list of frequencies and 
their programmed channel assignments are listed on the next page.  Refer to the 
Communications Action Plan for the frequency assignments. 

_______ 8. Microphone operation is as usual. 

2.  Memory Input (ref: page 25, 46, 48) 
The CARES Frequency line-up should already be loaded in memory.  However, if memory was lost, or 
new frequencies are needed, follow this procedure.   
This example will store 145.450 MHz with a - offset in Memory Channel 7. 

_______ 9. Press the VFO key  to select VFO mode. 
_______ 10. Enter the frequency by using the Tuning Control. 
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_______ 11. Set the Offset by pressing the SHIFT key (center group of controls, upper mid-left).  

The selection is advanced from “+” to “-“ to no offset, then repeats. 
_______ 12. Select the Tone.  Press the F key for longer than one second.  The F indicator will 

flash. Press the Tone key.  Use the Tuning Control to select the tone frequency.  
Once selected, wait for 10 seconds and the previous mode will resume.   

_______ 13. Press the Tone key.  A “T” appears above the frequency display. 
_______ 14. Press the F key momentarily (center group of controls, lower left).  The F indicator will 

appear, and a memory channel number will appear. 
_______ 15. Select Channel 7 by turning the Tuning Control. 
_______ 16. Press the MR button  within 10 seconds of selecting the memory channel number.  

The F indicator and memory channel number will turn off. 
_______ 17. To verify memory channel entry, select Memory Mode by pressing the MR button.  

The display should show the frequency and offset. 

3.  Power Control (ref: page 15) 
_______ 18. Pressing the LOW key (center group of controls, top right) steps from High (no 

indicator displayed), to medium (M indicator displayed), to low (L indicator displayed, 
and then back to high. 
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0430 Kenwood TM-401B 440 Transceiver Checklist 
 

1.  Power On Sequence 
_______ 1. Turn on the radio with the POWER/VOL knob . 
_______ 2. Adjust the Squelch  until any receiver noise is eliminated. 

 3. Ensure the REV Button  is in the OUT (off) position. 
 4. Ensure the COM button  is in the OUT position. 

_______ 5. Press the MR/M1 button to select channel 1.  For other channels, press MR/M1, then 
M2, M3, M4 for the desired channel.  Refer to the Communications Action Plan for 
the frequency assignments. 

 6. Set the TX Offset switch per the CARES Frequency setting below. 
_______ 7. Microphone operation is as usual. 

2.  Memory Input (ref: page 15) 
The CARES Frequency line-up should already be loaded in memory.  However, if memory was lost, or 
new frequencies are needed, follow this procedure.   
This example will store 440.100 MHz with a - offset in Memory Channel 1. 

 8. Press the VFO A/B toggle button  until A/B Indicator  is lit. 
_______ 9. Enter the frequency by using the Tuning Control and/or by pressing the MHz/M3 

button  to move in 1 MHz Steps. 
_______ 10. Press the M/M4 key .  The beep will sound 8 times. 
_______ 11. Depress the M1, M2, or M3 key while the beep is sounding.  A 1.5-second beep 

sounds to verify the memory input. 
_______ 12. To verify memory channel entry, select Memory Mode by pressing the MR button.  

The display should show the frequency and offset. 

3.  Power Control (ref: page 13) 
_______ 13. Depress the HI/LOW switch to reduce the power (1 Watts, button is depressed), 

press again to increase power (25 watts, button is not depressed). 

OFF

POWER/VOL          SQUELCH

KENWOOD          TM401B

A/B AL  M5 M  M4

MR  M1 MS  M2 MHz  M3

HI

LOW

COM

1          3           5
7      9       10

BUSY6.9 7 0
UHF  FM  TRANSCEIVERREV

Tuning Control &
Channel Selector

- S   +

TX OFFSET switch Power Level

2 4

6 8

1 3

7

5

OFF

POWER/VOL          SQUELCH

KENWOOD          TM401B

A/B AL  M5 M  M4

MR  M1 MS  M2 MHz  M3

HI

LOW

COM

1          3           5
7      9       10

BUSY6.9 7 0
UHF  FM  TRANSCEIVERREV

Tuning Control &
Channel Selector

- S   +

TX OFFSET switch Power Level

22 44

66 88

11 33

77

55
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0440 Kenwood TM-601S  EOC to EOC Radio Checklist 
 

 

1.  Power On Sequence 
_______ 1. Turn on the radio with the OFF/VOL knob . 
_______ 2. Adjust the Squelch  with the QT/QL know until any receiver noise is eliminated. 
_______ 3. Ensure the MONI button  is in the IN (depressed) position. 

 4. Ensure the NB (noise blank) button  is in the OUT (not depressed) position. 
_______ 5. Select the correct channel setting  : 

Channel 1 – Repeater (Normal setting) 
Channel 2 – Direct (on Repeater Failure) 

 6. Press the Microphone Push-to-Talk (PTT) button for 1 second.  Release the PTT 
button and listen to confirm the repeater is working. 

_______ 7. Microphone operation is as usual. 

2.  Ring-Down 
This radio provides the means to generate an annunciation tone at another station.  Each City in 
Santa Clara County is assigned a unique Ring Down code.  To initiate a Ring Down, do the following: 

_______ 8. To call all stations, enter #### (four #’s). 
 To call a single station, enter *nnn (see the list on the following page) 

_______ 9. Press the first digit for 1 second; then each subsequent digit for ~1/2 seconds each. 
_______ 10. After dialing the last digit, press and hold the PTT button, pause briefly, then begin 

speaking. 

3.  If our annunciation rings 
_______ 11. turn the power off, then on to silence the annunciation. 

1

1
MONI NB

TK-601S

OFF/VOL QT/SQL

TX BUSY

KENWOOD 

1           2         3    

4          5         6     

7          8         9     

*          O         #    

2

53 4 6

1

1
MONI NB

TK-601S

OFF/VOL QT/SQL

TX BUSY

KENWOOD 

1           2         3    

4          5         6     

7          8         9     

*          O         #    

1           2         3    

4          5         6     

7          8         9     

*          O         #    

1           2         3    

4          5         6     

7          8         9     

*          O         #    

2

53 4 6
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4.  Ring-Down Codes 
 

Location Designator Code 
County Communications COM *266 
Operational Area EOC EOC *637 
Op Area EOC Spare SPR *777 
Campbell CMB *262 
Cupertino CPT *278 
Cupertino Alternate CPO *276 
Gilroy GLR *457 
Los Altos CLA *252 
Los Altos Hills LAH *524 
Los Gatos LGT *548 
Milpitas MLP *657 
Monte Sereno MTS *687 
Morgan Hill MHL *645 
Mountain View MTV *688 
Palo Alto CPA *272 
San Jose CSJ *275 
Santa Clara SCL *725 
Saratoga SRG *774 
Sunnyvale SNV *768 
Lockheed Martin LMC *562 
NASA Ames NAM *626 
Palo Alto Red Cross PAR *727 
San Jose State University SJS *757 
SCV Water District VWD *893 
Stanford University SUF *783 
All Call n/a #### 
   
NOTE:  Some jurisdictions may not have ring down 
decoders. 
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0450 Kenwood TM-G707A  144/440 Transceiver Checklist 

 

1.  Power On Sequence 
_______ 1. Turn on the radio by pressing the PWR  button  (right side). 
_______ 2. Make sure the radio is in a known state, first by pressing the VFO key . 
_______ 3. Then, select Memory Mode by pressing the MR button . 
_______ 4. Adjust the Squelch ( right knob, outer ring). 
_______ 5. Adjust the Volume ( right knob, inner ring).   
_______ 6. Select the 2 meter band for transmit by PRESSING the BAND button.  Verify the 2 

meter band is displayed. 
_______ 7. Select the 2 meter channel with the Tuning knob .  The list of frequencies and their 

programmed channel assignments are listed near this operating position.  Refer to 
the Communications Action Plan for the frequency assignments. 

_______ 8. Microphone operation is as usual. 

2.  Memory Input (ref: page 28, 23, 24, 28) 
The CARES Frequency line-up should already be loaded in memory.  However, if memory was lost, or 
new frequencies are needed, follow this procedure.  

_______ 9. Press the VFO key  to select VFO mode. 
 10. Press the Band button  to select desired band. 

_______ 11. Enter the frequency by using the Tuning control . 
_______ 12. Set the Offset Direction for Repeaters by pressing the [F] then SHIFT buttons (see 

the menus).  The selection is advanced from “Simplex” to “+” to “-“, then repeats.  
Press [OK] when done (see menu). 

_______ 13. Select the Tone Frequency.  Press the Tone menu button.  Press [F] then T.SEL 
buttons (see the menus).  Turn the Tuning control until the desired tone is selected.  
Press [OK] when done (see menu). 

•Memory channel number

•Power indicator

VOL        SQL

TONE      REV        LOW         BANDF

_____1_____3_____5_____7_____9__________OVER

147.570
H

KENWOOD  FM Dual Bander TM-G707

CALL PWR
VFO
M>V
MR
M

PM

MNU

1
2

468

3

57

20

•Memory channel number

•Power indicator

VOL        SQLVOL        SQLVOL        SQL

TONE      REV        LOW         BANDFF

_____1_____3_____5_____7_____9__________OVER

147.570
H

KENWOOD  FM Dual Bander TM-G707

CALL PWR
VFO
M>V
MR
M

PM

MNU

11
22

446688

33

5577

20
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_______ 14. Turn Tone on.  Press the Tone menu button.  Repeat pressing Tone until T (Tone) is 
displayed.   

_______ 15. Store the Frequency.  Press the [F] menu button, a memory channel number 
appears.  Select the Channel by turning the Tuning Control.  Press the [MR] button 
to store. 

_______ 16. To verify memory channel entry, select Memory Mode by pressing the MR button.  
The display should show the frequency and offset. 

3.  Power Control (ref: page 17) 
_______ 17. Pressing the LOW menu key to Select M Medium power.  Change to H power 

depending on channel conditions. 
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0500 CARES EOC Packet Checklist 

1.  Before the Event 
_______ 1. Update CARES/Packet Procedures in SOP. 
_______ 2. Update Outpost and PacFORMs software.  Confirm the configuration of all components. 
_______ 3. Review and practice EOC Packet Procedures. 
_______ 4. Perform quarterly packet system checks. 

2.  During the Event 
 Alinco DR-235T  220 MHz Radio Power on Sequence  

 
_______ 5. Turn the radio on by pressing the PWR button  

_______ 6. Set the Squelch by pressing the SQL key .  The SQL  icon appears on the display and the 
squelch level will be shown.  Set the Squelch level to 2.  After 5 seconds, the display returns 
to normal. 

 7. Set the Volume level to so that the indicator is in the 10 o’clock position. 
_______ 8. Select Memory Mode by depressing the V/M key .  Verify that the M icon appears on the 

display. 
_______ 9. Rotate the MAIN Dial  to select the frequency: 223.660 MHz.   

_______ 10. Verify the Radio-to-TNC cable is connected. 
  

Terminal Node Controller (TNC) Power on Sequence 
_______ 11. Press the ON button on the TNC (located on the front).  Verify the power-on indicator lights. 

  
Computer Power on Sequence 

_______ 12. Turn on the Monitor (right-most button on the front).  Verify the monitor turns on. 
_______ 13. Turn on the PC (button center of front panel).  Verify the PC begins to Boot up. 

_______ 14. Log on to the PC:  LOGIN:   Administrator 
    PASSWARD:   <leave blank> 

_______ 15. Find the Outpost PPM icon on the Windows Desktop.  Double-click on this icon.  Verify the 
Outpost Program begins to run. 
 

Squelch setting

FUNC              V/M              MHz           TS/DCS         CALL            SQL

SET                  MW                SHIFT              LOCK H/L                  D

ALINCO VHF  FM  TRANSCEIVER  DR-235

DATA

TX

VOL    PWR

223.660SQL

02

2

3

4 5

1

Squelch setting

FUNC              V/M              MHz           TS/DCS         CALL            SQLFUNC              V/M              MHz           TS/DCS         CALL            SQL

SET                  MW                SHIFT              LOCK H/L                  D

ALINCO VHF  FM  TRANSCEIVER  DR-235

DATA

TX

VOL    PWR

223.660SQL

02

22

33

44 55

11
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 Confirm Outpost Setup 
_______ 16. From Outpost, select the menu options and confirm or set the following: 

 
Setup > TNC Tab 1: Interface Type:  Verify Device Name is KPC-3 and Device Type is TNC. 

Tab 4: TNC Comm Port:  Verity settings:  
Comm Port=1, Baud=9600, Data Bits=8, Parity=None, Stop Bits=1.   
Press OK when done. 

Setup > BBS Verify the BBS Name is W6XSC-1.  Press OK when done. 
Setup > Identification Enter your Call Sign in the User Call Sign field. 

Check the “Use Tactical Call…” box. 
Verity the Tactical Call Sign is set to CUPEOC. 
Press OK when done.  The Outpost Status Line will look something like this: 

 
Tools -> Send/Receive Settings Tab 1 Automation:  Check: No Automation 

Tab 2 Retrieving:  Check: Retrieve Private Messages 
Tab 2 Retrieving:  Check: Retrieve New Bulletins 

Tools -> Report Settings Tab 1 Variables:  Message Number: 100, or the next message number 
Tab 1 Variables:  Tac ID (3 Char): CUP 

Tools -> Message Settings Tab 1 New Messages: Check: Set default to Private 
Tab 1 New Messages: Check:  Default Destination, XSCEOC 
Tab 1 New Messages:  Check: Add Message Number to Subject Line 
Tab 3 Tracking:  Uncheck: all Receipt requests 
Tab 5 Advanced:  Check: Automatically Start Opdirect MCS… 

 
 Connect check 

_______ 17. From Outpost, Press Send/Receive button, top right.  Verify the Session Manager Form 
opens, Outpost connects to the BBS, and retrieves any messages, and closes. 

 

3.  After the Event 
_______ 18. Verify Outpost is not in the middle of a Send/Receive session.   

Press File -> Exit to exit Outpost. 
_______ 19. Turn off the Radio and TNC. 
_______ 20. Close all Windows programs. 
_______ 21. Shut down the Computer. 

_______ 22. Prepare a list of lessons learned, needed changes to checklists, and requests for additional 
supplies or equipment. 
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0501 CARES EOC Packet Message Creation 
 

 Creating and Sending Messages 
_______ 23. From Outpost, do the following: 

Press New.  A new Message window opens up.   
Address To: is XSCEOC (default, or change).  Enter a Brief subject after the Message 
Number.  Enter the Body of the message. 
Press Send when done. 
From Outpost, Press Send/Receive to send it now. 

  
Receiving Messages 

 24. New Messages will show up in the Outpost Intray.  Double-click on a message to read. 
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0800 CARES New Member Checklist 

1.  On Receipt of a CARES application 
_______ 1. Generate a welcome letter 
_______ 2. Confirm the applicant has a valid DSW card.  If not, direct them to the Director of 

OES for a City Volunteer application. 
_______ 3. Load the membership database. 
_______ 4. Generate a email or letter to the applicant to confirm the information received. 
_______ 5. Schedule an orientation session. 
_______ 6. Determine response intensions   

1=will accept a request to deploy and will pursue certification 
2=will accept a request to deploy but cannot pursue a certification 
3=will respond as part of an organized neighborhood or a CERT team 
4=can only operate from home 

_______ 7. Introduce the new member at their first Weekly Net check in. 
_______ 8. Introduce the new member at the next monthly meeting.  

2.  On completion of an orientation session 
_______ 9. Create the CARES name badge. 
_______ 10. Add to the CARES telephone tree. 
_______ 11. Determine intensions for pursuing field responder certification. 

3.  During the first field drill 
_______ 12. Issue a CARES vest 
_______ 13. Add to the CARES telephone tree. 
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0900 Field Antenna Kit Checklist 

1.  Before the event 
_______ 1. On a quarterly basis, inventory the antenna kit.  Refer to Step 6 below. 
_______ 2. Report any inventory or part discrepancies to CARES or the OES Logistics Section 

Chief. 

2.  During the event – Antenna Setup 
 3. Retrieve the Antenna Kit from its storage location.  You should receive a 6ft x 4in 

diameter tube with a tripod secured by bungee cord to its side. 
_______ 4. Lay the Antenna Kit on the ground. 

 5. Remove the 2 bungee cords and release the tripod.  Remove the screw top and set it 
aside. 

_______ 6. Remove the contents of the tubing.  Verify the following items are present: 
_________ Antenna Kit Checklist 
_________ Qty 2 – 6 ft mast sections (identical) 
_________ Qty 1 – Antenna-Mast adaptor 
_________ Qty 1 – J-Pole Antenna 
_________ Qty 1 – Coax Cable, 25 ft 
_________ Qty 1 – PL239(F) to BNC(M) adaptor 
_________ Qty 2 – Bungee cords, 18” 
_________ Qty 1 – Tripod 
 

  
Setting up the Tripod 
The tripod should be located close to the final operating position.  The tripod comes 
folded up and requires no assembly.   

_______ 7. Loosen the black knob located at the top junction of the three tripod legs.  The three 
legs can then extend to form a stand.  The legs should be extended until the support 
brackets that connect to the center pole are parallel to the surface.  Firmly tighten the 
twist knob. 

_______ 8. Adjust the height of the center poles.  Loosening the black-colored twist collars for the 
two extendable mast sections.  Extend the sections.  Tighten the twist collars when 
fully extended. 

  
Setting up the Mast and Antenna 

_______ 9. Lay the following sections down on the ground, end to end, starting closest to the 
tripod, in this order. 
(i) Mast section 1 
(ii) Mast section 2 
(iii) Antenna-Mast Adaptor 
(iv) Antenna. 

_______ 10. Insert the bottom of the 2nd mast into the top of the 1st mast.  Align the 1st mast button 
with the 2nd masts locking hole. 

_______ 11. Insert the Antenna-Mast adaptor on the top end of the 2nd mast.  Align the 2nd mast 
button with the Antenna-Mast adaptor locking hole. 

_______ 12. Insert the Antenna base into the Antenna-Mast adaptor.  
_______ 13. Connect one end of the coax to the antenna connector. 
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 Raising the Mast and Antenna 
NOTE: While the mast and antenna is light enough for one person to raise it, it is 
recommended that 2 people assist. 

_______ 14. With one person holding the base of the 1st mast steady, the 2nd person begins 
raising the antenna and walking toward the 1st person. 

_______ 15. With the mast and antenna in the vertical position, lift the mast high enough and slide 
it over the upper tripod extended section.  The mast should seat all the way down 
onto the Tripod twist collar. 

_______ 16. Connect the other end of the antenna coax to the radio.  Use appropriate adaptors as 
required to interconnect to your radio. 

3.  After the Event – Antenna take-down 
_______ 17. Remove the antenna cable from the radio. 
_______ 18. With 2 people, lift the mast off of the tripod, and gently lay it down as one assembly. 
_______ 19. Disconnect the coax from the antenna.  Coil the coax in large loops. 
_______ 20. Remove the antenna from the Antenna-Mast Adaptor. 
_______ 21. Press the 2nd Mast button and release the Antenna-Mast Adaptor. 
_______ 22. Press the 1st Mast button and release the 2nd Mast section. 

 23. Before inserting the antenna components back into the tube, make sure you have the 
following components: 
_________ Qty 2 – 6 ft mast sections 
_________ Qty 1 – J-Pole Antenna 
_________ Qty 1 – Antenna-Mast adaptor 
_________ Qty 1 – Coax Cable, 25 ft 
_________ Qty 1 – PL239(F) to BNC(M) adaptor 
 

_______ 24. Align the 2 mast sections, antenna, Antenna-Mast adaptor, and coax at the mouth of 
the storage tube. 

_______ 25. Gently compress the outer coax loops while sliding all sections into the tube.   
NOTE:  DO NOT FORCE OR FOLD THE COAX. 

_______ 26. Screw on the top onto the tube. 
_______ 27. Collapse the tripod by lowering the center 2 mast sections, retracting in the feet, and 

raising the tripod.  Tighten all collars. 
_______ 28. Position the tripod next to the tube center.  Place the 2 bungee cords such that they 

equally support the tripod.  Link the ends together so that they end up being tight. 
  

Missing Parts 
_______ 29. In the event you are missing any parts, please notify the Logistics Section Chief or 

individual issuing you the Antenna Kit.  We must get the parts replaced. 
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